
Adding Effects
to Flash Video

What we’ll cover in this chapter:

Different ways of masking video content.

Manipulating a movie clip’s properties, such as rotation, alpha, and
tint, to add creative effects to video content.

Using these properties to enhance the clarity of a video.
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As well as serving up straight video content, Flash gives us the opportunity to use its drawing tools to
customize our video. Properties such as color, size, rotation, contrast, brightness, and so on can all be
manipulated when a video is embedded in a movie clip. In this chapter, we’ll take a look at the available
properties (without any ActionScripting) to see how they can be used to create some cool effects, and
how they can help to integrate your video content within your overall web site design.

Before we examine these properties, we’ll take a brief look at some simple masking techniques, showing
how masking your video content can be used creatively to great effect.

Creative masking
In Macromedia Flash MX, video no longer needs to be displayed separately in its common rectangular
form. It can sit within an interface, snuggled up to the surrounding web site assets. There are two ways
you can achieve successful integration with the other web site elements: clever layering and masking.

Before we look at some examples, there are some important considerations to take into account when
you use either of these techniques: don’t cover up too much of your video! This might sound bizarre, after
all this is why we use masking, but there is simply no point in covering up large amounts of video that
could be trimmed out before importing into Flash – this just adds to the file size for no reason.

For instance, imagine using layering to fake a widescreen video. If
you’re anything like me, then you’ll (subconsciously) love those
ubiquitous black bars. If we import the following clip into Flash:

…and then fake the widescreen effect by adding two black rectangles,
placed on a layer that sits above the video layer in the timeline:

5 Flash MX Video

It is important to point out here that using masks (especially
animated masks) in Flash uses a considerable amount of processor
power, a resource that you won’t want to lose when displaying video.
The best thing to do is to test the mask effect on a number of
machines and see if there is any considerable lag.
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…we’ll pay a penalty (in terms of file size and by placing unnecessary demands on the user’s processing
power) for the areas of video covered by the black bars. If you wanted to recreate this effect, the best
solution would be to trim the video to the desired size in a video editing application before importing
it into Flash (the masking option in QuickTime Pro does a nice quick job). Another option would be to
export the movie in widescreen ratio (16:9). Then, you can do some faking in Flash, with the simple
black rectangles.

Let’s move on and look at using masks creatively with video. All of the source FLAs for the following
examples are available at the code downloads section for this chapter at www.friendsofed.com.

Masking with text

Using text as a mask is a quick way to spruce up that boring logo, but it needs to be used sensibly.
The amount of physical space that text takes up on the screen is minimal, so if you do use a mask
of text over your video, it’s quite possible that you’ll waste a great deal of the masked video
information. This information will still be in the file but the user will not be able to view it, so you’ll
pay for it with the file size. To justify using this technique, you need to find a good balance and let
enough of the video display through the mask to justify the masking text.

Let’s look at an example (if you want to look at this effect in detail, the source file is called
masking_with_text.fla).

It is quite well balanced, with much of the video on display,
allowing enough detail of the video to show through the text:

The mask is made up of a central rectangle, and above and below this,
I’ve used text that has been broken apart into a primitive graphic:

As you can see, it’s not difficult to make, but the effect looks pretty good and pulls together both
the video and the logo. What is best about this is that the video element really makes the page come
alive – a static JPG image just wouldn’t achieve the same desired effect on a web site dealing with
this kind of subject matter.
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Texture

When creating your masks, there are no definitive rules to follow. My advice is to choose the Brush tool,
scribble for a while on the stage, and then test the movie. Some of the results you get from just a little
improvisation are pretty inspiring and can often lead you to unexpected places.

The following mask example (masking_texture.fla) was created
simply by drawing a single line, converting it into a graphic symbol,
and then duplicating it to cover the whole video clip:

It’s worth noting here that you can’t make masks using strokes in Flash (such as lines created by the Pencil
and Line tools, and any stroke outlines from rectangles or circles). You can get round this by converting
your strokes into fills using Modify > Shape > Convert Lines to Fills. If you want to make a mask from
freeform lines then you can either follow the step above, or you can draw freehand with the Brush tool
(because this tool draws fills not strokes).

This is how the example mask looks on the stage in Flash:

I’ve extended the previous example by adding a motion tweened mask in
masking_texture_tween.fla. The mask begins off-stage at the top and then tweens vertically down
over the video all the way down until it moves below the stage.

In this example there is obviously the problem that we discussed earlier in the chapter: it is not file size
effective. Little of the video is shown at any time, and even though it’s a nice effect, it doesn’t make for
valuable content. Some important questions arising from this are:

What are you using the video for? 

Is the video one of the focuses of the web site or are you using it for creative effect?

How does the video add to the user experience?

5 Flash MX Video
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This next textured mask effect (masking_texture_edges.fla)
reminds me a little of the texture at the edge of an untrimmed
photograph from the darkroom. Besides taking away the dreaded
perfect edges, it also gives the clip a little raggedness – which is
perfectly suited to my BMX footage: 

This mask could be animated – we could add a number of different frames containing various scribbles –
to work with the footage and add more motion and character to it. The obvious difference between this
example and the last is that this (subtly) enhances the presentation of the video; it does not conceal it
nor drown it with overuse of the effect. 

The mask was made by drawing a rectangle to cover the whole video
clip, and then simply using the Eraser tool to roughly rub out
sections of the rectangle:

Multiple masks

If you have the patience to combine multiple masks and video movie clips you can produce endless
variations. The truth is that these may be of less immediate use than any of the previous examples we’ve
seen so far, but they’re still worth exploring. 

This first one (multiple_mask_skew.fla) uses two movie clips
containing the same video, which are then skewed. Two masks are
added to create a shape resembling an open book:
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This one requires a little more headwork than
the previous examples, but it’s relatively quick
and easy to build. Both video movie clips were
firstly centered, and then skewed to 30 and -30
degrees respectively. The masks were formed
using rectangles that were halved and then
skewed. Here are the two movie clips and their
respective masks: 

If you are interested in creating some mask effects of your own and need some inspiration, take a look
at Lifaros’ work with masks at www.friendsofed.com/fmc/lifaros.

Now that we’ve taken a quick look at masking effects, let’s move on to the movie clip symbol properties
that we can use to manipulate video in Flash.

Movie clip properties
They might sound a bit dull, but altering movie clips’ properties allows you to manipulate your video in a
number of cool ways. Properties give you more control over integrating your video in your web site, or
just give you a chance to go wild and experiment. 

Right now we’re going to look at each property individually and do an ultra-quick exercise for each one.
You may well recognize a number of these properties as we go along, but as we are leaning towards video,
you’ll probably learn something new.

If you want follow our examples exactly, we’re going to use properties_base.fla as the starting point
for all of the following exercises, and you can get it from the code downloads section for this chapter at
www.friendsofed.com.
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Remember: to check how the mask effect will look before publishing
or testing your movie, simply lock the mask and masked layers.
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Let’s kick off with the physical properties first (this first one is particularly apt for BMXing).

Everyone has watched TV upside down at one time or another. Fortunately, the novelty soon wears off
when the veins at the side of your head start throbbing! If you feel at all nostalgic for viewing video upside
down, you’ll be pleased to know that you can do it in Flash (and save yourself a headache in the process). 

1. Import a video file into Flash or open properties_base.fla from the download for this chapter.

2. Create a new movie clip symbol called ‘video’ and drag a copy of your embedded video file out of
the Library onto its timeline. Give the movie clip a central registration point and center the video
clip at (0,0).

3. Return to the main timeline and drag out four copies of your
movie clip onto the stage. Align them together like so:

We’re going to rotate two of these movie clips by 180 degrees to make a weird visual effect. 

4. Select the top left movie clip and open the Transform panel (Window > Transform). In the Rotate
section of the Transform panel, enter ‘180’ and press ENTER.

None of the properties we’re going to look at here will involve
scripting (we’ll ease off after the last chapter), but if you are
interested in using more advanced ActionScript to control video and
movie clips, this is covered in depth in Chapter 11.

Spinning around
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5. Repeat this step for the bottom right movie clip, again rotating it by 180 degrees.

6. Test your movie and sit back. Even though you’re only watching two angles of rotation, because of
the way that the movies are composed and are asymmetrical, it feels like more.

Besides entering numeric values to rotate the movie clips, you
can also rotate clips manually using the Free Transform tool
or by right-clicking on the movie clip and choosing Rotate and
Skew from the context menu. Both options allow you to
manually rotate an object – holding down the SHIFT key while
doing this constrains the rotation to 45 degree increments.

As a quick example of how rotating video can help integrate the video content snugly into a web site,
here’s a quick interface I came up with using a couple of videos rotated at 30 and -150 degree angles (see
rotation2.fla).

Skewing

As with rotation, skewing might only be useful in a small number of situations. One of these could be if
you’re designing a gallery interface where the videos are hanging on a gallery wall in the movie. You’d
need to skew the video to give a false impression of perspective. It can do pretty some pretty wacky
distortions and is worth playing around with to see what you can squeeze out of it.

5 Flash MX Video
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Here’s a screenshot from the world famous (ahem) web site BMX Cube (it’s cubic.fla in the
download files):

As you can see, the sides of the cube are skewed videos. Let’s look at how to make this.

1. Open up properties_base.fla from the download example or import one of your own video
clips into a new movie.

2. As always, create a new movie clip and drag a copy of the embedded video from the Library into
it. Agree to the frame extension dialog and center the video at (0,0) in the movie clip.

3. On the main timeline, drag two copies of the video movie clip
onto the stage. To allow more space for the BMX Biogs on the
top of the cube, scale both move clips’ width up to 130%
using the Transform panel (you’ll need to uncheck the
Constrain box).

Cubic
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4. Select the left movie clip and, using the Transform panel, set its vertical skew to 45 degrees. You
will need to check the Skew radio button first.

5. Select the right movie clip and set its vertical skew to -45 degrees. You should now have two
skewed movie clips:

6. Use the Align panel to align the movie clips along their bottom edge. Then position them so that
their vertical edges are touching. When moving one movie clip across to the other hold down
the SHIFT key to constrain the clip to the horizontal, so that they stay aligned correctly. When
they’re almost touching, zoom in close, and use the arrow keys on your keyboard to move them
pixel by pixel.

7. When you have them both lined up next to each other and touching, select both clips and group
them using Modify > Group.

8. Center the grouped movie clips horizontally on the stage using the Align panel. Now we’ve finished
the sides of our cube, we need to draw in the lid.

9. Create a new layer called cube and select the Rectangle tool. Choose an appropriate color in
keeping with your video clips and set the stroke width to 2 in the Property inspector.

5 Flash MX Video
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10. Draw a rectangle above the grouped clips. Don’t worry about the size and location on the stage
for now.

11. Select the rectangle on the stage and click on the Free Transform tool. Holding down the SHIFT key,
rotate the rectangle by 45 degrees:

12. With the rectangle still selected use the arrow keys to align it along the top edges of the video
clips. Finally, use the Free Transform tool to resize the rectangle into a perfect square that sits on
top of the clips, forming the cube shape:

All that remains for you to do is to add some text elements if you want to, and test your movie. 
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You could replace the current lid with another video movie clip (rotated and scaled) – I tried this, but
decided to stick with my colored cube… you can sometimes have too much of a good thing!

Flipping

When you are grappling with an image that doesn’t quite fit into a certain composition, simply flipping it
horizontally can often help (even though you might look back at it and be aware of the discrepancies).
The same idea applies to video – if it doesn’t seem to fit, consider flipping it. In most cases you can get
away with it, unless of course the video has any obvious distinguishing marks or flaws that makes it
unsuitable for mirroring.

1. Open properties_base.fla or import one of your own video clips into a fresh movie. As in the
previous exercises, create a new movie clip and drag a copy of your video from the Library into it.

2. On the main timeline, drag four copies of the video movie clip
onto the stage. Arrange the movie clips into a tight rectangle,
closed up around the center point with no gaps visible
between them:

3. Select the appropriate movie clips and use Modify > Transform > Flip Horizontal or Flip Vertical to
flip each clip as shown here:

no flips Flip Horizontal

Flip Vertical Flip Vertical and Horizontal

5 Flash MX Video
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4. Once you’ve done this, test the movie and travel back in time to the apogee of video mixing
effects, circa 1972. 

Combining rotation with flips can often get you some pretty cool results.

Brightness

If you’re working with dark or dull footage, you might welcome the ability to brighten them up in Flash.
The Brightness option also allows you to lighten or darken video, as you want. It’s set to zero by default,
and can be increased or decreased by values up to 100. 

You can change the Brightness property of a movie clip or symbol by selecting the symbol on the stage,
and choosing Brightness from the Color drop-down menu in the Property inspector:

Tint

If you thought any of the previous properties were cool, then prepare to be blown away by the Tint
option. Even though the name suggests a minor degree of coloring, the results you can get from using it
are pretty intense. If you work hard enough with this property, you could build that flashing disco floor
that you’ve always dreamt of. 

The Tint property is made up of two inputs: color (RGB sliders) and alpha. Here is full red with an alpha
value of 36%:

Once you’ve chosen a color, the alpha setting is used to increase or decrease the overall intensity of the
color. For example, a tint alpha of 100% would drown out a symbol with sheer color. 
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Besides opening up a new world in experimenting with video, the Tint option can also subtly enhance
colors in your videos. For example, if your video has a lot of red but lacks yellow you can lift the yellow;
or if your video has a lot of blue but you want even more of it then crank up the blue tones. This process
in Flash achieves a similar effect as using filters during film shoots, in order to enhance certain tones of
the video. 

Let’s try this out in an exercise.

1. Open properties_base.fla, or start a fresh movie and import a video clip of your own. Create
a new movie clip and drag the video from the Library into it. 

2. Return to the main timeline and drop six copies of your movie clip onto the stage. Arrange them
in a basic 3x2 grid format:

3. Select the top left movie clip and choose Tint from the Color drop-down in the Property inspector. 

Rather than be too fussy with our color choice here, we’re going to work with rainbow colors: red,
orange, yellow, green, blue and violet (admittedly, we’ve left indigo from the list!)

4. Choose red from the color selector and give it a tint alpha of 40%.

5. Select the remaining movie clips and set their tint to orange, yellow, green, blue, and violet,
working in a clockwise direction from the top center clip. Give each one a tint alpha of 40%.

When you are doing this, select a tone of color that lifts the video clip, rather than dulling it.
Remember that we’re representing the rainbow here and he likes to make people happy. 

6. Once you’ve done this, they should already look quite inviting. Save your movie as tint1.fla and
then test the movie. You’ll see that the tint alpha value we gave them is just enough – although
the tint colors take over, they still preserve some of the original color. If you feel this is too much
(or it might even be too little) go ahead and play with the tint alpha value. 

5 Flash MX Video
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If you take the tint alpha value much higher, you’ll veer into The Smiths album cover territory (The
Queen is Dead is a good example), but this might be the effect you are looking for. 

Okay, this isn’t the disco floor that I suggested earlier, but imagine that you’re with Lionel Richie
circa 1986 getting down on the ceiling and looking down at the dance floor. Or you could apply
some skewing to make a good old isometric dance floor. Darn it! Pixel Boy has escaped and is
strutting his stuff at the video disco (take a look tint2.fla included in the download files):

Alpha
The Alpha property is one of the most commonly used properties for all sorts of effects in Flash, ranging
from simple tweening to ActionScript-driven animation. The simple reason for this is that it allows you to
make an object appear out of nowhere, fading in from nothing into your web site or movie. In truth, the
scaling-and-fading-in-text trick is a little overused, but we can apply this old trick to video and give it a
new lease of life.

Right now, we’re going to use the Alpha property to create a cross dissolve transition in Flash. We’ll create
a sequence of two different video clips and then manipulate the alpha properties of each clip to create
a dissolve between them. (If you want to compare your file with ours as you go along then you can refer
to fade_in_fade_out.fla in the download files.)

As with masking, the alpha effect is also very processor-intensive so
you need to think carefully about how you go about using it in your
movies.

Fade in fade out
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1. Open alpha_base.fla from the download files for this chapter or locate two of your own video
clips and import them into a new Flash movie.

2. Create a new movie clip called ‘clip1’. Drag a copy of one of the videos into clip1. When you’re
greeted with the extend frames dialog, make a note of the length of the clip and click OK. Center
the video in your movie clip.

3. Insert a new layer called ‘actions’ on the movie clip’s timeline.
Locate the end of the video clip and insert a keyframe (F6)
above it in the actions layer. Add a stop action to this last
frame (in our example this is frame 206):

4. Double-click on the clip1 name in the Library and add the
number of frames (the length of this video) to its name:

5. Repeat the previous three steps for the other video clip in Library, placing it in a new movie clip
called ‘clip2’ initially, adding a stop action to the last frame of its timeline, and renaming the clip.

You should now have two movie clips in the Library, with
each name suffixed with the number of frames in the clip:

5 Flash MX Video
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6. Go back into the main timeline and insert two new layers. From
the top down rename the layers ‘actions’, ‘clip2’, and ‘clip1’:

7. Now we need to line up our clips on the stage. Drag a copy of the clip2 movie clip onto the clip2
layer, and drag a copy of clip1 onto the clip1 layer. Align both clips to the center of the stage.

8. We have to increase the frame length in the main timeline to equal the actual frame length of the
movie clips. So, if you’re using our source file, on the clip1 layer we should have 206 frames and
89 frames on the clip2 layer. If you are using your own video clips then these values will be
different. 

9. Insert a keyframe (F6) in the last frame of both layers. These keyframes will be used as tween
points.

Because my clip2 is much shorter than the other clip (89 frames compared to 206 frames), I’ve
decided to put it first in the sequence. We’ll let the shortest movie clip run from the start, so we
need to move the other clip further along in the timeline.

Because of the length of my clips (and a little experimentation), I’ve decided to use a 30 frame
crossover, which equates to just over a second at 25fps. 

10. Select the clip you want to place second in the sequence (clip1 in my file), and drag it along the
timeline so that it begins 30 frames before the other clip ends (at frame 59 in my file).

Now we need to create the fade in and fade out. Let’s start with the fade out.

11. Insert a keyframe (F6) at frame 59 of the clip2 layer (or the layer containing the first clip in your
sequence). 

12. In the same layer, select the keyframe at frame 89, and then select the movie clip on the stage.
Go into the Property inspector and choose Alpha from the Color drop-down menu. Set the alpha
to 0%.

13. Select any frame between the two keyframes and use the Property inspector to add a motion
tween. Your timeline should now look like the one pictured:
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If you now scrub the playhead over the frames containing the tween, you’ll see the first clip fade
out revealing the clip in the layer below. 

14. To get a perfectly smooth cross dissolve, we need to fade in clip1. Hide and lock the clip2 layer
to prevent us accidentally working with it. Insert a keyframe at frame 89 of the clip1 layer (or at
the frame corresponding to the end of the other clip’s fade out tween).

15. Select the video at keyframe 59 of the clip1 layer and set its alpha to 0%. Now select any frame
between 59 and 88 and insert a motion tween. Our clip1 will now fade in between frames 59
and 89:

16. That’s the visual elements of the movie finished. The last thing to do is to halt the movie at the
last frame to round off the sequence. Add a keyframe to the actions layer at the last frame of the
sequence (frame 264 of the source file). Add a stop action to this frame.

17. Now test the movie to see the neat cross dissolve transition take effect.

And that’s it on the Alpha property. Even though the alpha fade effect is used so frequently, the
simple reason for this is because it is quick to create and produces good results. You don’t always
have to combine it with a tween as we’ve just done here; you can also use it create subtlety (as a
faded video background) or for overlaying different video objects.

Advanced Effect

The final option in the Color drop-down menu we’ll look at is the Advanced Effect options. This is basically
a combination of the Tint and Alpha options, presented in a separate dialog box allowing us to accurately
enter these values.

Besides the obvious tinting and wild coloring, the Advanced Effect option can also help you to subtly
enhance your image or video. In the following exercise, we’ll go through a number of options to explore
the creative possibilities available to us using the Advanced Effects settings.

1. Open the properties_base.fla. As normal, place the video in a movie clip, extend the frames
and center it at (0,0).

On the main timeline, add a new layer called ‘control’. Rename the existing layer ‘test’.

2. Drag out two copies of the video movie clip from the Library and place one copy on each layer.
Position the clip on the control layer to the right of center stage, and place the clip on the test
layer to the left of center stage. The video on the right will act as a control clip to compare the
effect against, and the one on the left will have the effect applied to it.

5 Flash MX Video
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Lock the control layer so we don’t accidentally change any of the content on it.

The first thing we are going to do is sharpen up the video clip slightly, adding a little brightness
and changing the contrast.

3. Select the left clip and choose Advanced from the Color drop-down menu in the Property
inspector. Click on the Settings button and make the changes shown in the screenshot to the
settings in the Advanced Effect dialog:

4. Click on OK to apply the settings. Save your movie as advanced_sharpen.fla and then go ahead
and test it. You should see that the test video is lifted and altogether much improved and clearer
than the control clip:

The only negative point about this particular clip is that the test clip does appear to show more
effects of the compression because it is brighter, so it’s worth bearing this in mind when applying
this technique to your own video.

Close down the test movie, and leave the main movie open for the next quick exercise.

Because the colors in the Advanced Effect window can also be have a negative value, it allows us to suck
the specific color completely out of the graphic (down to 0%) and then begin to invert the color when we
set it below zero.

1. With the movie open from the last exercise, save it as advanced_color_inversion1.fla. 

Color inversion
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2. Back in the main timeline, select the test clip and apply the following settings in the Advanced
Effect dialog:

3. Test the movie and you’ll see that black has now become white, and vice versa:

This feels like an aged analog effect, usually seen in a low budget movie’s dream or madness
sequence. This effect can be useful in quick bursts to signal some kind of tension or approaching
moment. 

We’ll try out one more quick effect before we finish. This last effect strips out all of the colors in
the video except for black and red.

4. Close down your test movie; go back into the main timeline, and save the movie as
advanced_color_inversion2.fla. Select the test clip and make the following adjustments to
the Advanced Effect settings:

5 Flash MX Video
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5. Test the movie and you’ll see that the clip has a red and black monotone look. This is because
we’ve stripped out all the green and blue again. If you reverse the –255 value of the green, you’ll
see that the green replaces the black and looks a bit like a tie-died T-shirt – not pleasant! It does
show that the Advanced Effects dialog is a powerful beast and it’s probably best to keep
experimenting with these settings to see what you can come up with.

You can of course tween with the Advanced Effects settings, as with any of the other movie clip
properties. You could fade your clip to black (turn everything down except the alpha) or create a
transition between reality and a psychedelic dream sequence.

Summary
Even though we’ve looked at manipulating these properties in a fun way, they can be very beneficial in
making your video sit neatly within a web site interface. The Advanced option for example, can be used
to tint a video so that it matches a company’s brand color or the background color of the interface. The
rotation property can be used to orientate the video so that it fits in with angular graphics and
unconventional interfaces.

The main benefit of manipulating your content within Flash is that you can quickly test the effect (no
rendering is required) and you don’t have the expense of having to buy an editing application (such as
Adobe’s After Effects). Controlling your content in Flash, for instance coloring your videos, also means
that you save on having to import a number of different video clips specifically for the job.

So far, we’ve spent a fair amount of time dealing with the visual side of using video in Flash. It’s time to
move on and take a look at the equally important topic of sound…




